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Introduction

emesterers L swamwne ]

Only qualified persons who are knowledgeable in the installation, operation, and
maintenance of overhead and underground electric distribution equipment, along with
all associated hazards, may install, operate, and maintain the equipment covered by
this publication. A qualified person is someone who is trained and competent in:

e The skills and techniques necessary to distinguish exposed live parts from
nonlive parts of electrical equipment

e The skills and techniques necessary to determine the proper approach distances
corresponding to the voltages to which the qualified person will be exposed

e The proper use of special precautionary techniques, personal protective
equipment, insulated and shielding materials, and insulated tools for working on
or near exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons. They are not intended
to be a substitute for adequate training and experience in safety procedures for this
type of equipment.

Read this
Instruction Sheet

Thoroughly and carefully read this instruction sheet and all materials included in

the product’s instruction handbook before installing or operating the 6800 Series
Automatic Switch Control. Become familiar with the Safety Information and Safety
Precautions on pages 4 and 5. The latest version of this publication is available online
in PDF format at https://www.sandc.com/en/contact-us/product-literature/.

Retain this This instruction sheet is a permanent part of the 6800 Series Automatic Switch Control.
Instruction Sheet Designate a location where users can easily retrieve and refer to this publication.

Proper Application

The equipment in this publication is only intended for a specific application. The
application must be within the ratings furnished for the equipment. Ratings for the
6800 Series Automatic Switch Controls are listed in the ratings table in Specification
Bulletin 1045-31.
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Introduction

Special Warranty
Provisions

The standard warranty contained in S&C’s standard conditions of sale, as set forth in Price
Sheets 150 and 181, applies to the 6800 Series Automatic Switch Controls, except that the
first paragraph of the said warranty is replaced by the following:

(1) (1) General: The seller warrants to the immediate purchaser or end user for a
period of 10 years from the date of shipment that the equipment delivered will be of
the kind and quality specified in the contract description and will be free of defects
of workmanship and material. Should any failure to conform to this warranty appear
under proper and normal use within 10 years after the date of shipment, the seller
agrees, upon prompt notification thereof and confirmation that the equipment has
been stored, installed, operated, inspected, and maintained in accordance with the
recommendations of the seller and standard industry practice, to correct the noncon-
formity either by repairing any damaged or defective parts of the equipment or (at
the seller’s option) by shipment of necessary replacement parts. The seller’s warranty
does not apply to any equipment that has been disassembled, repaired, or altered by
anyone other than the seller. This limited warranty is granted only to the immediate
purchaser or, if the equipment is purchased by a third party for installation in third-
party equipment, the end user of the equipment. The seller’s duty to perform under any
warranty may be delayed, at the seller’s sole option, until the seller has been paid in
full for all goods purchased by the immediate purchaser. No such delay shall extend
the warranty period.

Replacement parts provided by the seller or repairs performed by the seller under
the warranty for the original equipment will be covered by the above special warranty
provision for its duration. Replacement parts purchased separately will be covered by
the above special warranty provision.

For equipment/services packages, the seller warrants for a period of one year
after commissioning that the 6800 Series Switch Control will provide automatic fault
isolation and system reconfiguration per agreed-upon service levels. The remedy shall
be additional system analysis and reconfiguration of the IntelliTeam® SG Automatic
Restoration System until the desired result is achieved.

Warranty of the 6800 Series Automatic Switch Control is contingent upon the
installation, configuration, and use of the control or software in accordance with S&C’s
applicable instruction sheets.

This warranty does not apply to major components not manufactured by S&C,
such as batteries and communication devices. However, S&C will assign to the imme-
diate purchaser or end user all manufacturer’s warranties that apply to such major
components.

Warranty of equipment/services packages is contingent upon receipt of adequate
information on the user’s distribution system, sufficiently detailed to prepare a
technical analysis. The seller is not liable if an act of nature or parties beyond S&C'’s
control negatively impact performance of equipment/services packages; for example,
new construction that impedes radio communication, or changes to the distribution
system that impact protection systems, available fault currents, or system-loading
characteristics.
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Safety Information

Understanding
Safety-Alert
Messages

Following Safety
Instructions

Replacement
Instructions
and Labels

Several types of safety-alert messages may appear throughout this instruction sheet and on
labels and tags attached to the product. Become familiar with these types of messages and
the importance of these various signal words:

A DANGER

“DANGER?” identifies the most serious and immediate hazards that will likely result in
serious personal injury or death if instructions, including recommended precautions,
are not followed.

“WARNING” identifies hazards or unsafe practices that can result in serious personal
injury or death if instructions, including recommended precautions, are not followed.

A CAUTION

“CAUTION” identifies hazards or unsafe practices that can result in minor personal
injury if instructions, including recommended precautions, are not followed.

“NOTICE” identifies important procedures or requirements that can result in product or
property damage if instructions are not followed.

If any portion of this instruction sheet is unclear and assistance is needed, contact the
nearest S&C Sales Office or S&C Authorized Distributor. Their telephone numbers are
listed on S&C’s website sandc.com, or call the S&C Global Support and Monitoring Center
at 1-888-762-1100.

Read this instruction sheet thoroughly and carefully before
installing the 6800 Series Automatic Switch Control.

If additional copies of this instruction sheet are required, contact the nearest S&C Sales
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be
replaced immediately. Replacement labels are available by contacting the nearest S&C
Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.
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Safety Precautions

A DANGER

A 6800 Series Automatic Switch Control’s line voltage input range is 93 to
276 Vac. Failure to observe the precautions below will result in serious
personal injury or death.

Some of these precautions may differ from your company’s operating procedures
and rules. Where a discrepancy exists, follow your company’s operating procedures

and rules.

QUALIFIED PERSONS. Access to a 6800 Series
Automatic Switch Control must be restricted only
to qualified persons. See the “Qualified Persons”
section on page 2.

SAFETY PROCEDURES. Always follow safe
operating procedures and rules.

PERSONAL PROTECTIVE EQUIPMENT. Always
use suitable protective equipment, such as rubber
gloves, rubber mats, hard hats, safety glasses, and

flash clothing, in accordance with safe operating
procedures and rules.

SAFETY LABELS. Do not remove or obscure
any of the “DANGER,” “WARNING,” “CAUTION,”
or “NOTICE” labels.

MAINTAINING PROPER CLEARANCE. Always
maintain proper clearance from energized
components.

S&C Instruction Sheet 1045-571
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Installing the Software on a Computer

Computer
Requirements

To install 6800 Series control software on the computer, the following are required:

A portable personal computer with Microsoft® Windows® 10, an Intel® Core™ i7
Processor with 8 GB of RAM (recommended) or a dual-core processor with 4 GB RAM
(minimum), a wireless card (onboard or USB), an Internet browser, and access to
sandc.com

Administrative privileges

Microsoft.Net Framework Version 4.8 (Verify the software has been installed on the
computer by opening CA\Windows\Microsoft. Net\Framework. If v4.8 has not been
installed, download it from this link: www.microsoft.com/net. If the installer does not
detect the correct version of .Net, it will not install IntelliLink6.)

Windows PowerShell 5.0 must be set for an AllSigned execution policy (RemoteSigned
and Unrestricted execution policies will also work). Policy selection should be based
on security policy set forth by the IT department. The AllSigned execution policy will
result in the appearance of a dialog, shown in Figure 1 on page 7, after a firmware
update has begun.

To perform the firmware update, select either the Run once or Always run button.

Selection should be based on the security policy set by the IT department. Windows
PowerShell comes installed by default in every Windows operating system.

Follow these steps to verify the Windows PowerShell execution policy:

STEP 1. Click on the Windows Start button and open All Programs>Accessories>

Windows PowerShell>Windows PowerShell (x86) to start the application.

STEP 2. Inthe PowerShell console, type: set-executionpolicy AllSigned to set the policy.

STEP 3. Inthe PowerShell console, type: get-executionpolicy to verify the policy setting.
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Installing the Software on a Computer

IntelliLink® Setup
Software License
Activation

The latest 6800 Series control software release is posted at the S&C Automation
Customer Support Portal. This library of present and legacy software requires a password
to provide users access to the software needed for S&C equipment operated by their utility.
See Figure 1. A portal password can be requested by using this link: sandc.com/en/support/
sc-customer-portal/.

Company Careers Support Customer Portal Fuse Store Language v

Q

\

S&C ELECTRIC COMPANY SOLUTIONS ~ PRODUCTS & SERVICES ~ NEWS & INSIGHTS ~ CONTACT US

Excellence Through Innovation

S&C Automation Customer Support Portal

S&C customers can use this secure website to download software and access technical support for the S&C Automation
Products they operate.

By logging into this Salesforce.com-powered portal, you agree to S&C’s End-User License Agreement and Third-Party End-
User License Agreement

LOGIN TO SECURE SITE

Figure 1. The S&C Automation Customer Support Portal is accessed on the Support tab at
sandc.com.

NOTICE

IntelliLink software version 7.3, and later does not need to be activated and is backwards
compatible with S&C automation controls with software version 3.5.x and later. If installed,
no license-activation file must be installed, and the user can disregard this section of this
document. If using IntelliLInk software with the IntelliCap® Plus Automatic Capacitor Control
or any other products with earlier software versions in conjunction with products using
software versions 3.5.x and later, users must obtain an IntelliLink software license key.

If unable to update to the 7.3 version, an account on the S&C Automation Customer Support
Portal is needed to obtain a license-activation file used with software versions 3.5.x to 7.1.x.
If lacking an account, follow the procedure to obtain one before proceeding.
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Installing the Software on a Computer

The first step is registering the computers that will require IntelliLink Setup Software.
Register a computer with the MAC address for the local area Ethernet adapter. The MAC
address can be obtained by using the ipconfig/all command in the command prompt.
Make sure to obtain the onboard physical adapter and not an add-on or wireless adapter.

If unfamiliar with the command prompt, obtain the S&C CheckMacAddress utility
found in the IntelliTeam SG Software workspace on the S&C Customer portal. See
Figure 2.

When the MAC address has been obtained, send an email to customerportal@sandc.
com with the name of the company that owns the IntelliLink software license, the name
of the primary computer user, and the computer user’s email address and phone number.
To see whether the computer is already registered, select the Licensing tab to view a list
of the computers registered to the account. Look for the designation of “INTELLILINK
REMOTE” next to the computer’s MAC address.

To see whether the computer is already registered, select the Licensing tab to view a
list of the computers registered to the account. Look for the designation of “INTELLILINK
REMOTE” software next to the computer’s MAC address.

Content
Search for Content
« Back
Search = in Clear
o InteliTEAM SG Software [+ for g — = [Go! [yt
: Search Results: Showing 1-9 of 9 resuilts |
‘ r* | Download Display Options. ‘
O @ Tite Size Last Modified Downloads
| {{| * IntelliTeam Designer 3.1.8.x Release Notes 8-3-12 32KB 8/2/12012 |
) &7  IntelliTEAM Designer Setup 3.1.8.0 26.0 MB  8/2/2012 ——
] (| IntelliTeam Designer 3.1.7.x Release Notes 3-1-12 31KB 3/8/12012 —
]} &7 IntelliTEAM Designer Setup 3.1.7.0 26.0 MB  3/8/2012 ——
] (| IntelliTeam Desinger Software Release Notes 3 0 x x 45KB 12/20/2011 (—]
= [(w| ReadMe _IntelliTeam Designer 3 0 x x 53 KB 12/20/2011 —
] & IntelliTEAM Designer Setup 3.0.1.0 244MB  12/20/12011 —_
] & IntelliTEAM Designer Setup 2.1.0.9 205MB  10/14/2011 —_
B & CheckMacAddress 17 KB 9/15/2011 —_
!

Figure 2. IntelliTeam SG Software workspace on the S&C Automation Customer Support
Portal.

The next step is to download and save the license-activation file, “ActivationFile.xml,”
as directed in the “Installing a License Activation File” section on page 9. An email noti-
fication will be sent that the activation file is ready. Log in to the
S&C Automation Customer Support Portal account and follow the steps in the “Installing a
License-Activation File” section on page 9.

When software version 3.5.x or later is installed and the license-activation file is saved,
IntelliLink Setup Software can be used with those products.

8
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Installing the Software on a Computer

Installing a License-
Activation File

Follow these steps to install a license-activation file:

STEP 1. Go to sandc.com, click on the Support tab, and then click on “S&C Automation
Customer Support Portal” in the left column. Enter a username and password
to gain access.

STEP 2. Select the Licensing tab and verify a valid license and the correct MAC address
is saved on the computer.

STEP 3. Select the Activation File tab. This generates a new license-activation file with
the present information displayed at the Licensing tab. Then, the File Download
screen opens.

STEP 4. Click onthe Save button and the Save As screen opens; save “ActivationFile.xml”
on the desktop.

Note: IntelliTeam® Designer software requires an account to have at least one asset regis-
tered with an IntelliTeam Designer slot. See S&C Instruction Sheet 1044-570, “IntelliTeam®
Designer: User’s Guide,” for more information about how to install and activate IntelliTeam
Designer software.

Save “ActivationFile.xml” in the folder: C:\\Users\Public\PublicDocuments\S&C
Electric. This directory supports multiple users logging remotely into a Windows server.
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Establishing a Serial or Wi-Fi Connection

NOTICE

Some laptop computers may have a Wi-Fi adapter power setting set too low for LinkStart
software to operate, resulting in the inability to connect to a 6800 Series Automatic
Switch Control. Wi-Fi power settings are found in the Control Panel. To increase the
Wi-Fi power setting:

STEP 1. Go to the Control Panel>Power Options setting.

STEP 2. Click on the Change Plan Settings option for the present plan.

STEP 3. Click on the Change Advanced Power Settings option.

STEP 4. Go to the Wireless Adapter Settings>Power Saving Mode>On battery
setting.

STEP 5. Change the setting to either Low Power Saving or Maximum Performance.
STEP 6. Click onthe OK button, and then click on the Save button to save the settings.
STEP 7. A reboot may be required to engage the new configuration.

The Wi-Fi adapter may have a vendor-supplied option to set the power, and many Intel
adapter drivers provide this. Open the Wi-Fi adapter Properties dialog box, and on the
General tab click on the Configure button. Browse the tabs to determine whether there
is a power setting (often found in the Advanced tab). There may be additional settings,
such as Transmit Power, that also can affect performance.

NOTICE

Port Requirements:
e |IntelliLink Setup Software has a valid port range of 20000-20999.
e LinkStart uses the following ports:

— TCP Remote: 8828

— UDP Remote: 9797

These two ports can be modified. To reconfigure either port, the port number must
be updated in both LinkStart and in the R3 Communication Module. To update a port
in LinkStart, select the Tools and TCP/IP Port Options menu options. Then, modify
the value.

To update a port in the R3 Communication Module, open LinkStart and
select the Tools and WiFi Administration menu options. This will open the
R3 Communication Module web Ul Login screen. Log in to the R3 Communication
Module, click on the Interfaces menu option, and update the port.
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Establishing a Serial or Wi-Fi Connection

Connecting to Follow these steps to establish a computer connection to the control:

the Control STEP 1. Click on the Windows Start button click on the All Programs menu item. Open
the S&C Electric folder and click on the IntelliLink icon. See Figure 3.

@ Photo Gallery

= Photos

i" PowerPoint
pr Publisher
B puTTY (64-bit)
S

S&C Electric

. Communication Server Console

Event Summary Viewer

% IntelliLink

@ IntelliLink Offline

% IntelliTeam Designer 7.5
% LinkStart

SCC1.9

E SpeedNet Client Tool

SpeedNet SNMP Client

- S&C Electric Battery Charger

S

Figure 3. The Windows Start menu.

STEP 2. Select the Local Connection option in the S&C IntelliShell-Select
Connection Mode dialog box. See Figure 4.

B S&C IntelliShell - Select Connection Mode - X
Local Connection Remote Connection
(Serial or WiFi) (Serial or IP) anieEs

Figure 4. The S&C IntelliShell—Select Connection Mode dialog box.
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Establishing a Serial or Wi-Fi Connection

STEP 3. Selectthe Series 6800 IntelliTeam II/SG option and click on the Serial button
to make a serial connection, or click on the Wi-Fi button to make a Wi-Fi connec-
tion. See Figure 5.

|
X

S&C IntelliShell - Product Selection

Select S&C Product Family
Series 6800 IntelliTEAM 1I/SG v

Series 6800 IntelliTEAM I1/SG
IntelliCap 2000

| seial || wiFi |

Figure 5. The S&C IntelliShell—Product Selection dialog box.

STEP 4. When the Serial button is selected:
(@ Setthe Comm Port setpoint appropriate for the computer.
(b) Set the Timeout(ms) setpoint to 1000 or longer.

(c) Set the Baud Rate setpoint. The default baud rate for an IntelliLink
software connection is 9600. If the baud rate setting was changed and is
unknown, use the Auto setting, and the IntelliLink software will try the
available baud rates to attempt to make a connection.

(d) Click on the IntelliLink button. See the “Update Firmware” section on
page 17 when a firmware update is required. See Figure 6.

m S&C IntelliShell - Local Communication Setup

-Serial Settings

Comm Port: Baud Rate:
Timeout, ms: Retries: E] Update Firmware

Use Default Timeout

|
O
X

Figure 6. The Communications Parameters entries in the S&C Electric IntelliShell—
Local Communication Setup dialog box.
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Establishing a Serial or Wi-Fi Connection

When the Wi-Fi button is selected:

(@ Usethe Prev and Next buttons to select the control serial number, or enter
the control serial number in the Serial Number field.

Note: The control serial number is displayed on the Setup>General>SG6800

screen in the Device Serial Number field.

(b) Click on the Connect button. See Figure 7.

B WiFi Connection Management - O X
File Edit Tools

Connect to a Device

Device Name: |6801M
Device Location: | 807-Test Lab

LLRRRRRREY
)

Figure 7. The Wi-Fi Connection Management dialog box.

STEP 5. The S&C IntelliLink Loader dialog box will open followed by the S&C IntelliLink
Login dialog box. See Figures 8 and Figure 9 on page 14. Enter the username
and password, and click on the OK button. Contact the Global Support and
Monitoring Center at (888) 762-1100 when assistance with these entries is needed.
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Establishing a Serial or Wi-Fi Connection

S&C IntelliLink Loader

link Loader utility. Version: 613.13.

Copyright © S&C Electric Company 2005 - 2021. All rights reserved
Trying to connect:
> Connection: Serial port: COM3, baud rate: auto

> Protocol: DNP, local address: 65432, Peer DNP Address: 65532
> Timeout: default, Retries: 2|

Figure 9. The S&C IntelliLink Loader dialog box.

B S&C IntelliLink Login X

User Name

[admin ]

Remember my User Name

Password
| |

[C] Show Password

| Login || Cancel |
Figure 8. The User Name and Password entries in the S&C IntelliLink Login dialog box.

STEP 6.

If IntelliLink software is unable to connect, the S&C IntelliLink Loader dialog box
will display “Could not connect to device.” Check the connection and settings.
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Establishing a Serial or Wi-Fi Connection

NOTICE

With software versions 7.3.100 and later, the default passwords for all user
accounts, including the Admin user, must be changed before the IntelliLink software
can connect to and configure a control. See S&C Instruction Sheet 1045-530,
“6800 Series Automatic Switch Controls: Setup,” for more information.

NOTICE

Wi-Fi Status and Transfer Wi-Fi configurations became no longer valid for Wi-Fi options
shipped on or after January 1, 2021.

STEP 7. When the login has completed, the Operation screen appears. See Figure 10.

File Connection Data Tools Help

LANA i ] {

6801M Automat Connected to: Location:
Switch Operatc

Operation
IntelliTeam SG
Setup
Metering - e .
Diagnostics _— e
Communication Tests -
Logs - ) N

Graphs

Validate

Apply

Operation

REMOTE

o]

Hot Line Tag

Shots to Lockout i
\

Q
@
o
2
=
o
=
@
i
@
&
n

Manual Operation ( Clear Clear Inspection Required Clear
Battery Status Normal ‘ Control Status Message OKAY

Battery \Voltage 0 Auto Operation Status Disabled

Battery Backup Hours 96 h Switch Position (% Closed) 0

Manual Op. Handle Removed External Temperature -50°F -46°C

Control Status ERROR

Feature Selected None

Figure 10. The 6801/2/3 Automatic Switch Control Operation screen.
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Firmware Update

Save Settings

Complete the following steps to save the control configuration:

STEP 1. On the menu bar, click on the File menu item and click on the

Save Setpoints... option.

STEP 2. In the Save Setpoints dialog box, click on the Select All button followed by the

... button. See Figure 11.

STEP 3. The Windows Flile Explorer screen will open. Browse to the desired storage
location, enter a name for the settings file to be saved, and click on the Save

button in the dialog box.

Updating firmware can result in loss of settings. Always save the settings and
a snapshot file before starting a firmware update.

m Save Setpoints

Connected Device Information
Snapshot

Save as

User Comment

O Security
b General
b Restoration
b Communication

X

Select All| [ClearAll] [ Save | [ Cancel | |

Exit

Figure 11. The Save Setpoints dialog box.

STEP 4. To save a snapshot (a copy of the control memory, including logs), click on the
File menu item in the menu bar and click on the Save Memory Snapshot option.
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Firmware Update

NOTICE

Before beginning a firmware update, verify both the new firmware version and the firmware
version existing in the control have been properly installed on the computer performing
the update. If the existing firmware is missing, the update will not execute properly.

NOTICE

Two files with the same firmware version for example, 7.5.23 and 7.5.36, must not be
installed on the computer during a firmware update or downgrade.

Updating firmware can result in loss of settings. Always save the settings and save a
snapshot file before updating firmware.

The configured operating modes for automatic Enabled/Disabled operation, SCADA
control Remote/Local operation, and Hot Line Tag On/Off settings on the Operation
screen are retained through a firmware update, whereas the operating modes for shots
to lockout and automatic restoration are reset to “Blocked” and “Prohibited” defaults
respectively). Review the IntelliLink Operation screen.
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Firmware Update

Update Firmware

NOTICE

A remote or local update puts a control into the Prohibit Restoration state. When
updating controls in an IntelliTeam SG Automatic Restoration System, use the following
procedure:

STEP 1. Update the control software. This can be done with IntelliLink® Setup
Software or the IntelliLink software Remote option.

STEP 2. After the update, verify all settings were preserved.

STEP 3. Use the IntelliTeam Designer version compatible with the firmware version
the control is running to re-push IntelliTeam SG Automatic Restoration
System configurations to all FeederNets that have updated devices. See S&C
Instruction Sheet 1044-570 for the firmware compatibility chart.

STEP 4. If a device is an open point, push the configuration to both FeederNets for
that device.

STEP 5. Verify the team configurations.

STEP 6. For IntelliNode modules only, set the External Device Data Updated setting
to Running mode.

STEP 7. Enable Automatic Restoration mode on all updated controls.

Complete the following steps to update the firmware:

STEP 1. Start the IntelliLink software and select between a local or remote connection.
See Figure 12.

S&C IntelliShell - Select Connection Mode — <
Local Connection Remote Connection
(Serial or WiFi) (Serial or IP) CANCEL

Figure 12. The S&C IntelliShell—Local Communication Setup dialog box.

STEP 2. Selectthe Series 6800 IntelliTeam II/SG option to update a 6800 Series control.
Click on either the Serial or Wi-Fi button based on the communication method
used to connect to the control. See Figure 13.

B S&C IntelliShell - Product Selection = O X

Select S&C Product Family
ISelies 6800 IntelliTEAM II/SG v

Figure 13. The S&C IntelliShell—Product Selection dialog box.
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Firmware Update

STEP 3. When the Serial button is selected:
(@ Setthe Comm Port setpoint appropriate for the computer.
(b) Set the Timeout(ms) setpoint to 1000 or longer.

(¢) Set the Baud Rate setpoint. The default baud rate for an IntelliLink
software connection is 9600. If the baud rate setting was changed and is
unknown, use the Auto setting, and the IntelliLink software will try the
available baud rates to attempt to make a connection.

(d) Click on the Update Firmware button. See Figure 14.

n S&C IntelliShell - Local Communication Setup - O X

Serial Settings
Comm Port Boud Rate:
Timeot ms e 2|

Use Default Timeout

Figure 14. The S&C IntelliShell—Local Communication Setup dialog box.

STEP 4. For Wi-Fi connections, LinkStart software starts and the device serial
number must be entered in the Serial Number field. Then, click on the Connect
button. See Figure 15.

B WiFi Connection Management = O X
File Edit Tools

| Connect to a Device

Device Name: |6801
Device Location: |

|
|

Figure 15. The Wi-Fi connection Management dialog box.
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Firmware Update

STEP 5. When the connection is successful, click on the Firmware Update button. See
Figure 16.

B WiFi Connection Management — [ X

File Edit Tools

Connect to a Device ] o

Device Name: | |
Device Location: |
Serial Number: | 08-9000240 |

Disconnect IntelliLink Firmware Update

Figure 17. The connection successfully completed indication.

STEP 6. Inthe Tools menu onthe menu bar click on the Firmware Update menu option.
See Figure 17.

B 5G6802vista(#65520) - S&C IntelliLink Setup Software [613.13)
File Connection Data Help
| Options...

Figure 18. The Tools>Firmware Update menu option.

STEP 7. When the firmware update Choose Revision dialog box appears, select the
firmware version to update the control to. See Figure 18.

Note: This dialog box only appears if the control is already on the version the
upgrade is being performed on. Otherwise, it will not appear, and the upgrade
script will upgrade the control to the latest firmware downloaded on the
computer where the upgrade is being performed.

Choose Revision
Choose 7.5.33 to Upgrade, any other revision to Downgrade
|_1.s_3ﬂ|7.3.61| [7.1.24| | 63.11 | | Cancel |

Figure 16. The Choose Revision dialog box for selecting the firmware version.
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Firmware Update

STEP 8. The Firmware Update dialog box will prompt for selection of the upgrade method.
Click on one of the options to proceed. See Figure 19.

Note: This step is only displayed when upgrading from software version
7.3.x to 7.5.x or later.

Note: The Compact Flash option is more robust because it downloads the
firmware image to the compact flash memory before applying the firmware
update. This should be used when updating remotely because it compensates
for communication disruptions but takes longer to perform. The Legacy option
is less robust because it sends the firmware file to the control and applies the
update without staging it in the compact flash memory. It should only be used
with a local connection to the control.

| Firmware Update

Choose upgrade method: Compact Flash (more secure). Legacy (faster).
| (Compact Flash | [ Legagy|

Figure 19. The Firmware Update dialog box upgrade method choice.

STEP 9. The Firmware Update dialog box may ask about the MCU OS revision. Click on
the Yes button if this dialog box appears. See Figure 20.

Firmware Update

Upgrade Choice
The revison of the MCU OS in the control, 2.2.33.0, has a revision higher than or equal to the upgrade revision, 2.2.33.0. Upgrade anyway?

i
Figure 20. The MCU OS revision dialog box.

STEP 2. Inthe Firmware Update dialog box, click on the Yes button. See Figure 21. Selecting
“No” will end the Update process.

Firmware Update

You are about to upgrade the control:
MCU 0§ 2.2.33.0to 2.2.33.0
MCU App 7.5.53.5 to 7.5.53.5

WARNING: If you are connected through the master DNP address, then you must set all of the appropriate master
communication parameters on the DNP screen before upgrading, or you may lose communications.

For example, if you are communicating over Ethernet, then the Master IP Address must be set to the proper

address, and 'the Master Station Port Code must be set correctly. If you are communicating over a serial port,
then you must set the Master Station Port Code to the correct port.

Continue?
ey

Figure 21. The Firmware Update dialog box.
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Firmware Update

STEP 11. When upgrading the firmware from version 7.3.x to 7.5.x and the Firmware Update
dialog box prompts to retain passwords, click on one of the options to proceed.
See Figure 22.

Note: This dialog box only appears when upgrading from software version

7.3.x to 7.5.x. When upgrading from any release to version 7.6.x or later, the
existing passwords will be retained. If the passwords are still at the default pass-
words, then the admin user will be required to change them to one that meets
the password complexity requirements upon initial login after the firmware
update is completed.

Firmware Update

Retain Passwords?
Click Yes to Retain Passwords, No to set them to defaults
[es] [Na

Figure 22. The Firmware Update dialog box requesting password retention.

Note: When “Yes” is selected, all user passwords are retained during the
update. However, if the passwords do not meet the complexity requirements,
the Admin user must change them at the initial login after an update to meet the
requirements. See Figure 23.

When “No” is selected, after the update all passwords will revert to the defaults.
At initial login all passwords must be changed to meet the password complexity
requirements.

[EareUpdzate

Warning

Passwords must not be default and must be 8-12 characters long with at least one upper and one lower case character. Please confirm that your passwords meet
these requirements. If they do not, you may exit now to change them or you will be required to change them upon the next login following the update.

(Continue ] ((Exit)

Figure 23. The Firmware Update dialog box requiring passwords that meet complexity
requirements.
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Firmware Update

STEP 12. If the Windows PowerShell Credential dialog box appears: Enter the User
Name and Password, and click on the OK button. Contact the Global Support
and Monitoring Center at (888) 762-1100 if assistance is needed. See Figure 24.

B Firmware Update O X

Validating Settings. This could take up to 12 seconds.
Validate completed successfully
Upgrading SG6802vista from 7.5 to 7.5, 2022-05-19T111203

Saving Settings to: C:\Users\ N W al\OneDrive - S & C Electric Company
\Documents\S&C Electric\Products\SG6802vista
\SG6802VvistaSettings-7.5-2022-05-19T111203. xspt

MCU 0S 2.2.33.0 ->» 2.2.33.
MCU App 7.5.53.5 -» 7.5.53
Waiting for control to fin

Windows PowerShell credential...

i take up to 30 seconds.
Enter your credentials. I P

User Name: | admin

Password:

Figure 24. The Windows PowerShell Credential dialog box.
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Firmware Update

STEP 13. When “Script completed successfully” is indicated in the Firmware Update dialog
box, click on the Close button. See Figure 25.

Firmware Update O X

validating Settings. This could take up to 12 seconds.
validate completed successfully
Upgrading SG6802Vista from 7.5 to 7.5, 2022-05-19T111203

Saving Settings to: C:\Users\lhwww o = \OneDrive - S & C Electric Company
\Documents\S&C Electric\Products\SG6802Vista
\SG6802VistaSettings-7.5-2022-05-19T111203. xspt

MCU O0S 2.2.33.0 ->» 2.2.33.0

MCU App 7.5.53.5 -> 7.5.53.5

waiting for control to finish restarting. This could take up to 30 seconds.
Restoring Settings

Applying Settings. This could take up to 12 seconds.

First Apply successful; Second Restore and Apply Proceeding

Applying Settings. This could take up to 12 seconds

Second Apply successful

Resetting passwords to default

These files contain saved and/or generated settings files:

Source settings file: C:\Users\IN " 3i\OneDrive - S & C Electric
Company\Documents\S& Electric\Products\SG6802Vista
\SG6802VistaSettings-7.5-2022-05-19T111203. xspt

Script completed successfully. Upgrade or Downgrade succeeded

[interrupt | [Cica3]

Figure 25. The Script completed successfully notice.

NOTICE

If power is disrupted during a firmware update using the Compact Flash option, Cyclic
Redundancy Check (CRC) errors may occur and, if seen, the compact flash must be
formatted before another update can be attempted using the Compact Flash option. Or
at that point, the Legacy option can be used to perform the update. See the “Memory
Formatting” section in S&C Instruction Sheet 1032-570, “IntelliLink® Setup Software—
Compact Flash Access: Operation.”
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Firmware Downgrade

In some cases it may be necessary to revert to a previous version of 6800 Series control
firmware. Follow these steps to change to a previous version:

STEP 1. Choose the required firmware revision and obtain the software from the
S&C Automation Customer Support Portal. See the “Software Versions®
section in S&C Instruction Sheet 1045-530 for more information about the
S&C Customer Portal.

STEP 2. Click on the Start button, and select the Control Panel option.
See Figure 26.

B Windows System

Command Prompt
g; Control Panel
™ File Explorer
B Run
¥ Task Manager
«= ThisPC
Windows Administrative Tools
WinPcap
Wireshark

Word

Work or school account

Xbox Console Companion

Xbox Game Bar

Figure 26. The Windows Start Menu.
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Firmware Downgrade

[ Control Panel

7

« = v 4 E> Control Panel

v |0

|Search Control Panel

Adjust your computer's settings

e
s
«
a

System and Security
Review your computer's status

Save backup copies of your files with File History
Backup and Restore (Windows 7)

Network and Internet
View network status and tasks
Hardware and Sound
View devices and printers

Add a device
Adijust commonly used mobility settings

Programs

Uninstall 2 program  ffm—

Get programs

Viewby: Category v

User Accounts
&) Change account type

Appearance and Personalization

Clock and Region
Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

Figure 27. The Control Panel dialog box.
STEP 3. From the Control Panel dialog box, select “Programs.” See Figure 27.

STEP 4. Uninstall all 6800 Series control software versions later than the target
version. If there are multiple revisions, work from the latest first to the earliest
downgrade version last.

STEP 5. If any IntelliLink Setup Software is already installed, remove it by uninstalling

it from the Windows program with the Uninstall option. See Figure 28.

« = v 4 Il > ThisPC > OSDisk (C) > Program Files (x86) > S&C Electric > Products v ‘ 9] I I O Search Products

" ~

2 Name Date modified ‘ Type Size
I 12000 2/3/2022 4:57 PM File folder
I IntelliNode 2/8/2022 12:09 PM File folder
[ IntelliRupter 1/14/2022 3:53 PM File folder
B IntelliRupterR3 3/9/2022 1:01 PM File folder
B sGeso1 2/8/2022 9:30 AM File folder
[ sG6801E33 2/8/2022 9:43 AM File folder
B SG680TMSX 2/7/2022 2:46 PM File folder

Figure 28. The selected program folder to be uploaded.
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Firmware Downgrade

STEP 6. Open Windows F'ile Explorer screen and navigate to the program folder
C:\Program Files (x86)\S&C Electric\Products\<product folder downgrading to>\
Firmware\Upgrades. See Figure 29. Delete any folders that have a version number
later than the target downgrade version.

| 3 @ = | Upgrades - [m} X

B o e v -~ q
¢« > v 4 |B « S&CElectric > Products > SG6801 > Firmware > Upgrades v [ 3} | ‘ P Search Upgrades
Name Date modified | Type Size

W 6117 2/8/2022 9:30 AM File folder

. : ile folder
B 6311 2/8/2022 9:32 AM File fold
W 7124 2/8/2022 9:33 AM File folder
B 7361 2/8/2022 9:35 AM File folder

4/19/. 31 AM ile folder
W 7533 9/2022 83 Fi

B ThispPC
@ 3D Objects
[ Desktop

Figure 29. The C:\Program Files (x86)\S&C Electric\Products\<product folder>\Firmware\
Upgrades dialog box.

STEP 7. Runtheinstaller for the target version. If the target downgrade version is already
installed, select the Repair option when it is presented by the installer.

With software later than version 7.3.100, the default passwords for all user
accounts, including the Admin account, must be changed before the IntelliLink
software can connect to and configure a control. See S&C Instruction Sheet
1045-530, “6800 Series Automatic Switch Controls with IntelliTeam® SG
Automatic Restoration System: Setup,” for more information.

STEP 8. Start the IntelliLink software.
STEP 9. Set the Timeout(ms) setpoint to 1000 or longer.

STEP 10. Set the Baud Rate setpoint. The default baud rate for an IntelliLink
software connection is 9600. If the baud rate setting was changed and is unknown,
use the Auto setting, and the IntelliLink software will try the available baud
rates to attempt to make a connection.

STEP 11. Click on the Update Firmware button. See Figure 30.

Communications Parameters:

Comm Port Baud Rate IntelliLink
Retries |2

Protocol ’ Update Firmware
Use Default Timeout © ICP @ DNP >

Figure 30. The S&C Electric IntelliShell - Local Communication Setup dialog box.
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Firmware Downgrade

STEP 12. Enter the Admin password when prompted to enter credentials. The default
password can be obtained by contacting the Global Support and Monitoring
Center at (888) 762-1100. If the default password has been changed, enter the
user-configured password.

STEP 13. In the Tools menu on the menu bar, click on the Firmware Update menu item.
See Figure 31.

File Connection .. Data. [Jigglal] Help-
‘[{ H bty o | Options.
— | BasicOptions Summary
Firmware Update...
Compact Flash Access...
Operation _ .
IntelliTeam SG Device Maintenance...
L Onfsen

Figure 31. The Tools>Firmware Update menu option.

STEP 14. When the Firmware Update Choose Revision dialog box appears, select the
desired firmware version. See Figure 32.

Choose Revision

. Choose 7.5.33 to Upgrade, any other revision to Downgrade

(2533 ] (7361 (7.0.24] [ Cancel |

Figure 32. The Firmware Update Choose Revision dialog box for selecting the firmware
version.
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Firmware Downgrade

STEP 15. The Firmware Update dialog box will prompt for selection of the update or
downgrade method. Click on one of the options to proceed. See Figure 33.

Note: This dialog box only appears when downgrading from software version
7.5.x or later to another 7.5 release or a 7.3 release.

Note: The Compact Flash option is more robust because it downloads the
firmware image to the compact flash memory before applying the firmware
update. This should be used when updating remotely because it compensates
for communication disruptions but takes longer to perform. The Legacy option
is less robust because it sends the firmware file to the control and applies the
update without staging it in the compact flash memory. It should only be used
with a local connection to the control.

| Firmware Update

Choose upgrade method: Compact Flash (more secure). Legacy (faster).
Compact Flash
| ((Compact lash | | Legacy

Figure 34. The Firmware Update dialog box.

STEP 21. The Firmware Update dialog box may ask about the MCU OS revision. Click on
the Yes button if this box appears. See Figure 34.

Firmware Update

Upgrade Choice
The revison of the MCU OS in the control, 2.2.33.0, has a revision higher than or equal to the upgrade revision, 2.2.33.0. Upgrade anyway?

[y
Figure 33. The MCU OS revision dialog box.

STEP 15. In the Firmware Update dialog box, click on the Yes button. See Figure 35.
Selecting “No” will end the Downgrade process.

Firmware Update

You are about to upgrade the control:
MCU 0S 22.33.01t0 2233.0
MCU App 7.5.53.5 to 7.5.53.5

WARNING: If you are connected through the master DNP address, then you must set all of the appropriate master
communication parameters on the DNP screen before upgrading, or you may lose communications.

For example, if you are communicating over Ethernet, then the Master IP Address must be set to the proper

address, and the Master Station Port Code must be set correctly. If you are communicating over a serial port,
then you must set the Master Station Port Code to the correct port.

Continue?
by I

Figure 35. The Firmware Update dialog box.
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Firmware Downgrade

STEP 16. When downgrading from a software version of 7.3.100 or later to a software
release earlier than 7.3.100: A message appears about the passwords being
reverted to defaults during the downgrade process. Click on the Yes button to
proceed with the downgrade. Selecting “No” will stop the downgrade process.
See Figure 36.

Note: When downgrading from a software version 7.6.x or later to a
7.5.x or 7.3.1x version: The passwords will always be retained. If any of the
users account passwords are still at the default value, the Admin must change
them to a password that meets the complexity requirements before those user
accounts can login.

m Firmware Update Jail X

pDowngrading SG68023PM from 7.5 to 7.3, 2022-08-11T195937

Firmware Update

Default Passwords

After the downgrade, all passwords will revert to their default values. Continue?

Figure 36. The Default Password downgrade message.

STEP 17. Ifthe Windows PowerShell Credential dialog box appears, enter the same password
entered in Step 12 on page 28. See Figure 37.

Downgrading SG6801 from 7.3 to 7.1, 2022-08-23T211225

Saving Settings to: C:\Users\devadmin\Documents\S&C Electric\Products\SG6801
\SG6801settings-7.3-2022-08-23T211225.xspt

MCL OS 2.2.27.0 -> 2.2.18.0
MCU App 7.3.158.3 -> 7.1.24.1
Firmware loaded. Resetting prgcessors

waiting for control to fin Wi mis PosEhal ciagirtal. take up to 30 seconds.

Enter your credentials.
User Name: admin

Password: |

OK | _. Cancel |

Figure 37. The Windows PowerShell Credentials dialog box.
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Firmware Downgrade

STEP 18. When downgrading from a software version of 7.3.100 or later to a software
version 7.3.x or earlier, a message will appear about the passwords being reverted
to defaults after the downgrade process completes. Click on the OK button to
proceed. See Figure 38.

m Firmware Update =

Downgrading SG68023PM from 7.5 to 7.3, 2022-08-11T195937

Saving Settings to: C:\Users\devadmin\Documents\S&C Electric\Products
\SG68023PM\SG68023PMSettings-7.5-2022-08-11T195937 .xspt

MCU OS 2,2.33.0 =-> 2.2.27.0

MCU App 7.5.53.5 => 7.3.158.3

waiting for control to finish restarting. This could take up to 30 seconds.
Restoring Settinas

Applying Setting pjiyare Upilate

First Apply succ

Applying Setting wWaARNING

second Apply suc

Apply completed All user passwords have been reverted to the default passwords. Please use the default password when logging into

the device. It is recommended that you change the password to a unique password once logged in for security purposes.

Figure 38. The message that appears after reverting passwords to defaults after a down-
grade process completes.

STEP 19. When “Script completed successfully” is indicated in the Firmware Update dialog
box, click on the Close button. See Figure 39.

Firmware Update O X

Downgrading SG6801 from 7.3 to 7.1, 2022-08-23T211225

Saving Settings to: C:\Users\devadmin\Documents\S&C Electric\Products\SG6801
\SG6801Settings-7.3-2022-08-23T7211225.xspt

MCU 0OS 2.2.27.0 -» 2.2.16.0

MCU App 7.3.158.3 -> 7.1.24.1

Firmware loaded. Resetting processors

waiting for control to finish restarting. This could take up to 30 seconds.
Restoring Settings

Applying Settings. This could take up to 12 seconds.

First Apply successful; Second Restore and Apply Proceeding

Applying Settings. This could take up to 12 seconds

Second Apply successful

These files contain saved and/or generated settings files:

Source settings file: C:\Users\devadmin\Documents\S&C Electric\Products
\5G6801\SG6801Settings-7.3-2022-08-23T211225.xspt

Script completed successfu11y|

\

| Interrupt Close

Figure 39. The “Script completed successfully” message.
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Software Update with Battery Power

S&C recommends the switch control use both battery and ac control power (or
battery and sensor power, if applicable) when updating the control software. If the control
software must be updated at alocation where no ac control power is available, follow these
instructions to override the automatic shut-down procedure.

Protection System Logic

The CPU directs all functions of the switch operator, including charging and
monitoring the battery system. When the CPU program stops, the control will not function,
and the battery or circuits might be damaged.

To indicate the CPU program is functioning properly, it sets a bit on the PS/IO board
every few seconds. When that bit is not set for 60 seconds, the PS/IO board disconnects
the battery. This shuts down the control and prevents damage to the control circuits and
battery.

During the update process the CPU is unable to function and cannot set the bit on the
PS/IO board. The protection logic disconnects the battery 60 seconds or less after the
update process begins.

When ac control power (or sensor power) is present, the control continues to operate
without battery power and completes the software update. However, if ac control power
(or sensor power) is not present, the control shuts down, terminating the software update.
There is no damage to the control, and the update process can be started again.

Manually Overriding the Battery Disconnect Command

The control software can be updated manually using only battery power by manually
sending a Battery On command to the PS/IO board. To do so, press the BAT ON switch
every 30 seconds. This black momentary-contact switch is located on the PS/IO board. See
Figure 40 on page 33.

Updating the control software may take up to 15 minutes. Pushing the
BAT ON switch is usually easier than moving the control to a location with ac control
power (Oor sensor power).

32
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Software Update with Battery Power

BAT ON button

Battery connected
LED

R146 TP11

‘ - oA
Figure 40. The BAT ON button and Battery Connected LED on the PS/1O board.
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